Windows Kernel Exploitation Tutorial Part 1:
Setting up the Environment

X June 19,2017 £L rootkit

Intro

Recently, | had the pleasure to attend the training on Windows Kernel Exploitation at nullcon by the Hack-
SysTeam. The training was well executed, and | got the intro into the world of kernel. But, as you know,
nobody could teach you internals about Kernel Exploitation in a couple of days. So | thought of diving into
the kernel, and share everything that | learn in the process. The series would be coming in parts, as | find
the time to learn and document everything that | encounter.

Prerequisites

e VMWare or Virtualbox (I'll be using VMWare for this series)
e Windows 7 x86 VM

e Internet Connection for downloading symbols

e Powerful enough machine to run the VMs

e Basic know-hows in day to day computing tasks.

Why VMs?

Visualize kernel as the heart of OS. Now, if you have done any application exploitation in the past, you'd
know that you basically crash the application and try to exploit the crash. Applications can easily be re-
covered once crashed, just double click to run again. Now, if you accidentally crash the kernel, it's like stop-
ping the heart, the OS would just halt/crash/BSOD, and could lead to loss of data, corruption etc. in your
machine, and you'd be constantly rebooting the whole machine. VMs are easily setup, isolated and causes
no harm if corrupted. Many people just run the Debugee VM (the machine which you'd be crashing alot) in
the VM, and keep their host as the Debugger machine. I'd be running the setup where both of them would
be VM, just to keep things neat and tidy.

Steps
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1. Install Windows 7 x86 in the VM, free download is available at Microsoft VM download page.

[ ] microsoft.com

Tech 25 Jocumentation

Microsoft Edge Web platform - Community - Tools - Demos Feedback & support

Download virtual machines

Test Microsoft Edge and versions of IE8 through IE11 using
free virtual machines you download and manage locally.

Select a download

Virtual machi

IE11 on Wir

DOWNLOAD .ZIP >

2. After the Debugger VM is setup and ready to boot, we'd need to install WinDbg, get it here.
3. We'd also need to setup Debugging Symbols in the Debugger VM. Fortunately, Microsoft provides pub-
lic debugging symbols.
e Go to Computer —> Properties -> Advanced system settings -> Environment Variables.
e Create a new System Variable as follows:
e Variable Name: _NT_SYMBOL_PATH



https://developer.microsoft.com/en-us/microsoft-edge/tools/vms/
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e Variable Value: SRV*C:\Symbols*https://msdl.microsoft.com/download/symbols

System Properties

Computer Name | Hardware | Advanced | System Protection | Remote

Environment Variables

Mew System Variable

Variable name:

Variable value:

Variable

ComSpec

FF_NO_HOST_C...
MUMBER_OF_PR...

e
s

_HT_STMEGL_RHTW

SRAV=C:\Symbols*https://msdl.microsoft.o

oK

Windows_NT

Mew...

EXH

|| Cancel

4. After WinDbg is installed, we would need to enable debugging in BCD:
e Run cmd as administrator, and execute the following commands:

I8 bcdedit /copy {current} /d "Win7Dbg"
PA bcdedit /debug {0275edo4

=1 bcdedit /dbgsettings

} on

Administrator: C\Windows\System32\cmd.exe

debugtype
debugport
baudrate

C:\Windows\system32>_

Microsoft Windows [Uersion 6.1.7601]
Copyright (c) 2009 Microsoft Corporation.

C:\Windows\system32>bcdedit /dbgsettings

Serial
1
115200

The operation completed successfully.

All rights reserved.

C:\Windows\system32>bcdedit /copy {current} /d "WinTDbg"
The entry was successfully copied to {0275ed04-3¢c06-11e3-alcO0-b6bd309a633d]}.

=

C:\Windows\system32>bcdedit /debug {0275ed04-3c06-11e3-alcB-b6bd309a633d} on
The operation completed successfully.




5. Now, we'll create the Debugee VM, by creating a linked clone of the Debugger VM
6. Power off the Debugger VM, Right Click -=> Manage -> Clone.

Clone Virtual Machine Wizard

Clone Source

Which state do you want to create a clone from?

Clone from

(@) The current state in the virtual machine

Creating a linked clone from the current state will create a new snapshot

This virtual machine has no existing cloneable snapshots.

< Back

Cancel

Clone Virtual Machine Wizard ﬂ

Clone Type

How do you want to clone this virtual machine?

Clone method

(@) Create a linked clone

A linked clone is a reference to the original virtual machine and requires

less disk space to store. However, it cannot run without access to the
original virtual machine.

() Create a full clone

A full clone is a complete copy of the original virtual machine at its current

state. This virtual machine is fully independent, but requires more disk space
to store.

7. Now, we need to enable Serial Ports on both the VMs, so as to make them communicate using a Virtual
Serial Port.




e For the Debugger VM, Right Click -> Settings -> Add -> Serial Port
Virtual Machine Settings

Hardware | Options

Device Memory

W Memary Specify the amount of memaory allocated to this virtual
machine. The memory size must be a multiple of 4 MB.

[l Processars
{eea Hard Disk (IDE) L . . 24 =] ma
CD/DVD (SATA) Add Hardware Wizard ﬂﬂ :
E_"—jNetu’.fnrk Adapter

(3 UsB Controller Serial Port Type
\f Sound Card What media should this serial port access?

I8 Display
) mmended memory

ping may
[ Use physical serial port on the host his size.)

Serial port
() Qutput to file

(@) Qutput to named pipe

mended minimum

Cancel

Cancel




Virtual Machine Settings

Hardware | Options

Device Summary Memory
¥ Memory 1 GB Specify the amount of memory allocated to this virtual
[ Processors 1 machine. The memory size must be a multiple of 4 MB.
i Hard Disk (IDE) 127 GB o ies
DV AT A . -
CD/DVD (SATA) Add Hardware Wizard H
E_‘I-jNew.rork Adapter
BUSE Controller Specify Socket
\f Sound Card Which socket should this serial port connect to?
8 Display
Named pipe mmended memory
ping may
\\-\pipe\KernelDbg his size.)
This end is the server. W
The other end is an application. W memory
Device status
Connect at power on mended minimurm
< Back Finish Cancel

“p Add...

oK Cancel Help




Virtual Machine Settings

Hardware | Options

Device status

Device Summary
M Memory 1GB Connected
[l Processors 1 Connect at power on
(Hard Disk (IDE) 127 GB
CD/DVD (SATA) Auto detect Connection
E_‘@Nehr.rnrk Adapter  NAT () Use physical serial port:
BUSB Controller Present
\f Sound Card Auto detect Auto detect
L':' Serial Port Using named pipe \\.\pipe\KernelDbg () Use output file:
| pisplay Auto detect -

(@) Use named pipe:

Y\-\pipe\KernelDbg

This end is the server. W
The other end is an application. W
I/O mode

[+]Yield CPU on pall

Allow the guest operating system to use this serial port
in polled mode (as opposed to interrupt mode).

“p Add... Remave

OK Cancel Help




e For the Debugee VM, Right Click -> Settings -> Add -> Serial Port
Virtual Machine Settings

Hardware | QOptions

Device Summary Memory

#EEE Memory 1 GB Specify the amount of memaory allocated to this virtual
machine. The memory size must be a multiple of 4 MB.

[l Processors 1

\ewd Hard Disk (IDE) 127 GB o o =
CD/DVD (SATA) Add Hardware Wizard Hﬂ )

@Netwnrk Adapter

g USE Controller Serial Port Type

x,f Sound Card What media should this serial port access?

MB

| pisplay

Serial port mmended memory

ping may
{_) Use physical serial port on the host his size.)
() Output to file

(®) Output to named pipe

mmended minimum

Cancel

Cancel




Virtual Machine Settings

Hardware | Options

Device Summary Memory
0K Memary 1 GB Specify the amount of memory allocated to this virtual
[ Processors 1 machine. The memory size must be a multiple of 4 MB.
=i Hard Disk (IDE) 127 GB o 24 =] g
DV AT A = e
CD/DVD (SATA) Add Hardware Wizard H
IE,I_ll—:]Net'nr.fnrk Adapter
E USB Controller Specify Socket
\f Sound Card Which socket should this serial port connect to?
W pisplay
Named pipe mmended memaory
ping may
'\'\.'\pipe'\l{ernethj his size.)
This end is the client. W
The other end is an application. W memaory
Device status
Connect at power on mmended minimum
< Back Finish Cancel

‘¥ Add...

oK Cancel Help




Virtual Machine Settings

Hardware | Options

Device Summary Device status

0 Memory 1GB Lonnected
[ Processars 1 Connect at power on
(Hard Disk (IDE} 127 GB
CD/DVD (SATA) Auto detect Connection
%Netwnrk Adapter  NAT () Use physical serial port:
EUSE Controller Present
\f Sound Card Auto detect
E Serial Port Using named pipe \\.\pipe\KernelDbg () Use output file:
| Display Auto detect -

(®) Use named pipe:
\\.\pipe\KernelDbg
This end is the client.

The other end is an application.

/O mode
[#]vield CPU on poll

Allow the guest operating system to use this serial port
in polled mode (as opposed to interrupt mode).

“¢ Add... Remove

Cancel

8. Now, turn on the Debugger VM first (always), and select the first option without the [debugger enabled].

Windows Boot Manager

Choose an operating system to start, or press TAB to select a tool:
(Use the arrow keys to highlight your choice, then press ENTER.)

indows 7 >

win7Dbg [debugger enabled]

To specify an advanced option for this choice, press F8.




9. After the Debugger VM is booted up, open up the WinDbg -> File -> Kernel Debug -> COM.

'%l WinDbg:10.0.15063.400 X86

l'.-'l oW Uepu |;; '._.".~.' ndow

Kernel Debugging

NET |USB |1394 |Local | COM

Kemel debugging over a COM port or virtual serial device
Baud Rate: .

Pipe
115200

Port Reconnect

coml Resets:

0

OK | | Cancel

@J Kernel ‘com:port=com1,baud=115200" - WinDbg:10.0.15063.400 X86

View Debug Window Help

t

[=] Command - Kernel ‘com:port=com1,baud=115200' - WinDbg:10.0.150634{>—] = | & |[s3sl

Copyright (o) Microsoft Corporation.

Opened ~~ . wcoml
Waiting to reconnect. ..

Hicro=soft (R) Windows Debugger Version 10.0.15063.400 86
All rights resserved.

|Debuggee not connected




10. Now, boot up the Debugee VM, and select the second option with [debugger enabled].

wWindows Boot Manager

Choose an operating system to start, or press TAB to select a tool:
(Use the arrow keys to highlight your choice, then press ENTER.)

Windows 7

in7Dbg [debugger enabled] >

To specify an advanced option for this choice, press F8.

11. Now, if you see the following output in the WinDbg in your Debugger VM, congrats, everything is work-
ing fine.
_:'_§.| Kernel ‘com:port=com1,baud=115200" - WinDbg:10.0.1

ft (R) Wind 1 Y zion 10.0.15
ht (=) Hicr rporation. All right

ipatible target at (Mon Jun 19 08:2
ed .

vmbol=*ht tps

11 MF {1 pro
.win?=pl_gdr.

[Debuggee not connected

12. Now, after the Debugee VM is booted up, hit the Break button, and you should get an interactive kd>
prompt, ready to take commands.




'%J Kernel 'com:port=com1,baud=115200" - WinDbg:10.0.15063.400 X8&6
File Edit View Debug Window Help
| &= | | || 6B S EEREE OB E|[E | A 5

Command | Break (Ctrl+Break) I

HMicrosoft (R} Windows Debugger Version 10.0.15063.400 X886
Copyright (o) Microzoft Corporation. All rights reserwved.

Opened . coml
Waiting to reconnect. .

Connected to Windows ?.?601 286 compatible target at (Mon Jun 19 03:20:44. 881 2017 (UTC — 7:00)). ptred FALSE
Kernel Debugger conhection established.

*xkxerke*xk** Synbol Path validation summary ¥ee%Ee6ee ke

Response Time {m=) Location

Deferred SEV=C ~Symbols*http=: v mnedl microsoft com-download-symbols
Symbol =ssarch path i=s: SEV=C:“~Symbols=https: s mn=dl microsoft.con-dovnload-symnbols

Executable =search path i=:

Windows 7 KEernel Version 7601 HF (1 procs) Free =86 compatible

Built by: 7601.18409 =86fre. win¥spl gdr. 140303-2144

Machine Hame:

Kernel base = 0=82a09000 P=s=loadedModuleli=t = 0=x82B525B0

Sy=ztem Uptime: not awvailable

ernel ‘com:port=com1,baud=115200" - WinDbg:10.0.15063.400 X86

.'.-'. ew Lenu ';E '._.'.i.' ndow Help

(23 == Bt e | N EAGEEREOE B [Eh] Al

Command - Kernel ‘com:port=com1,baud=115200" - WinDbg:10.0.15063.400 X86

Symbol search path i=: SEV=C:“~Symbol=s*http=:-~m=d]l microsoft con download-symbols
Ezxecutable search path is:

Windows 7 Kernel Version 7601 HP {1 procs) Free x86 compatible

Built by: 7601 18409 =B6fre winVspl_gdr. 140303-2144

Hachine Hame:

Kernel ba=e = 0x82a09000 PsloadedHoduleli=st = 0x82b525h0

Sy=sten Optime: not awailable

KDTARGET: Refreshing KD connection

Bresl instruction exception — code 800000032 (first chance)

Tou are =eeing this message becaus=e vou pressed either
CTRI+C (if yvou run console kernel debugger) or.
CTRI+BEEAK (if wou run GUI kernel debugger).

on wvour debugger machine's kevboard.

THIS IS HOT A& BUG OR &4 SYSTEM CRASH

If wou did not intend to break into the debugger. press the "g" key.
press the "Enter” key now. This message might immediately reappear.

does, press "g" and "Enter' again.

*
*
*
*
*
*
*
*
*
*
*
*

ok ok ok ok ok K ok ok k ok %

nt IRt lpBreakWithStatusInstruction:
82a837b8 cc int 3

4

[led >

13. Now, just to be sure that the symbols have been loaded correctly, run the following commands:

Isym noisy
.reload




'@' Kernel ‘com:port=com1,baud=115200" - WinDbg:10.0.15063.400 X86

View Debug Window Help

| [V e e |0 EEEEERE OB E | [E] A

Command - Kernel 'com:port=com1,baud=115200" - WinDbg:10.0.15063.400 X86 ENR= | (=] ||£§-|

82a837b8 co i 3 -
kd> lsym noisy
noizy mode — symbol prompts on
kdr .reload
Connected to Windows 7 7601 =86 compatible target at (Mon Jun 19 08:29:56.224 2017 (UTC - 7:00373.
SYMSEV: BYINDEX. 0=5
o waynbols*https: ~vun=dl nicrosoft  com download-symbols
ntkrpamnp. pdb
AB1Z63CEAC444E518224A213E053A5D72
SYMSEV: PATH: o wsymbolssntkrpamp. pdb~ABl263CEACA444ER18224A713E053A5D7 2 ntkrpanp . pdb
SYMSEV: RESULT: 0=z00000000

DEGHELF: nt — public symbols

c:weynbols ntkrpanp. pdb~AB1263CE4C444E518224 421 3E053A5D7 2 ntkrpanp . pdb
Loading Eernel Symbols

Fress ctrl-c {(cdb, kd. nt=sd) or ctrl-break (windbg) to abort =ymbol loads that take too long.
Fun !sym noisy before .reload to track down problem= loading symbols.

Loading User Symbols

Loading unloaded module list
4

[led s

Conclusion

Congrats, we have successfully setup Kernel Debugging. The next part would be coming up soon, digging
deeper into the kernel, and analyzing the Stack Overflow in Kernel Space.
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